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Abstract
Aim: Coronavirus-2019 (Covid-19) primarily affects the respiratory system, and how it affects respiratory muscles and lung volume 
is still not fully understood. Our study aimed to assess the time-dependent changes that may occur in lungs and respiratory muscle 
sizes on chest computed tomography (CT) in adult coronavirus disease 2019 (COVID-19) patients.
Material and Methods: The clinical and radiological records of 101 adult patients who had at least two non-contrast chest CT images 
in stage 1 (0-4 days) and stage 6 (>28 days) were collected retrospectively. ImFusion Suite program were used to calculate lung 
volumes, and the cross-sectional areas of the pectoral and intercostal muscles were also calculated using with “ImageJ” program.
Results: One-hundred one patients (51 females, 50.49%) were included in the study. ANCOVA revealed a significant stage*side 
interaction effect regarding cross-sectional area (CSA) of intercostal muscles [(p=.010; η²p=.064)]. There was no significant 
difference between the two stages in terms of CSA of pectoralis major and minor muscles [(p=.314; η2p=.010), (p=.644; η²p=.002)] 
respectively and lung volume [(p=.340; η²p=.009)].
Conclusion: Covid-19 pneumonia causes an atrophy in respiratory muscles. However, it seems to have a nonsignificant effect on 
auxiliary respiratory muscles and lung volume. Further investigation of respiratory muscles and respiratory muscle training to reduce 
the risk of serious complications during viral infections are required. 
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Öz
Amaç: Coronavirus-2019 (Covid-19) öncelikle solunum sistemini etkiler ve solunum kaslarını ve akciğer hacmini nasıl etkilediği hala 
tam olarak anlaşılamamıştır. Çalışmamız erişkin koronavirüs hastalığı 2019 (COVID-19) hastalarında akciğer bilgisayarlı tomografisinde 
(BT) akciğerlerde ve solunum kası boyutlarında zamana bağlı olarak oluşabilecek değişiklikleri değerlendirmeyi amaçladı.
Materyal ve Metot:  Evre 1 (0-4 gün) ve evre 6’da (>28 gün) en az iki kontrastsız göğüs BT görüntüsü olan 101 erişkin hastanın 
klinik ve radyolojik kayıtları geriye dönük olarak toplandı. Akciğer hacimlerini hesaplamak için ImFusion Suite programı kullanıldı ve 
pektoral ve interkostal kasların kesit alanları da “ImageJ” programı kullanılarak hesaplandı.
Bulgular: Yüz bir hasta (51 kadın, %50,49) çalışmaya dahil edildi. ANCOVA, interkostal kasların kesit alanına (KA) ilişkin önemli bir 
evre*yan etkileşim etkisi ortaya çıkardı [(p=.010; η²p=.064)]. Sırasıyla pektoralis major ve minor kaslarının KA’sında [(p=.314; η²p=.010), 
(p=.644; η²p=.002)] ve akciğer hacminde [(p=.340; η²p=.009)] iki evre arasında anlamlı bir fark bulunmadı.
Sonuç: Covid-19 pnömonisi solunum kaslarında atrofiye neden olur. Ancak yardımcı solunum kasları ve akciğer hacmi üzerinde önemsiz 
bir etkiye sahip olduğu görülmektedir. Viral enfeksiyonlar sırasında ciddi komplikasyon riskini azaltmak için solunum kaslarının daha 
fazla araştırılması ve solunum kas eğitimi gereklidir.
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INTRODUCTION
The world has been struggling with coronavirus 2019 
(Covid-19), which appeared in Wuhan, and spread 
rapidly causing a pandemic (1). Due to the risk of rapid 
contagion, early diagnosis, isolation, and early treatment 
interventions are of great importance in these patients. 
The Real-Time Polymerase Chain Reaction (RT-PCR) test 
is used to considered the gold standard for diagnosis; 
however, the drawbacks of the test include false-negative 
results especially in the early period of the disease, the 
time-consuming nature of the test, and the unavailability 
of the test facilities in some places (2).  Thus, radiological 
methods in identifying the characteristic findings of Covid-
19-induced pneumonia are important for early diagnosis 
and follow-up of the patient’s prognosis (3,4). Considering 
the adverse impact of the Covid-19 infection on the lungs, 
chest radiology and computer tomography (CT) are 
extensively used to verify lung involvement (5).

Thin-section CT is an important tool in the early detection, 
monitoring, and evaluating the efficiency of the treatments. 
At the onset of the disease, the sensitivity of the RT-PCR 
test and chest CT are 71% and 98%, respectively; indicating 
the reliability of using CT primarily in symptomatic cases 
with suspicious chest X-ray who are prone to develop 
complications (3). Some studies in the relevant literature 
have reported that the normal lung volume may decrease 
due to alveolar collapse in patients with Covid-19 
pneumonia (6). Additionally, the proinflammatory effects of 
Covid-19 and the deconditioning during the convalescent 
period may lead to losses in both muscle strength and 
endurance (7). However, long-term follow-up studies and 
objective data on the subject are scarce (8).

Previously published studies have evaluated the typical 
and atypical CT degree of Covid-19 pneumonia (9), the 
time-dependent variation of CT findings (10), and the 
correlation between CT features and clinical characteristics 
(11). However, to the best of our knowledge, there are no 
studies investigating the time-dependent changes in lung 
volume and respiratory muscle sizes in Covid-19 patients, 
and respiratory muscle performance and lung volume are 
important in developing early rehabilitation strategies. For 
these reasons, our study aimed to determine the possible 
time-dependent changes that may occur in lungs and 
respiratory muscle sizes on the CT images of patients 
which diagnosed with Covid-19.

MATERIAL AND METHOD
Study plan and study population

Ethical approval for this study was obtained from the 
Ankara Medipol University Medical Faculty Clinical 
Research Ethics Committee (Registration date/no: 
Registration date/no: 23.09.2021/35). This retrospective 
study imposed no risk for the participants and informed 
consent was waived. Our cohort composed of 101 patients 
subjected to the RT-PCR test for suspicious Covid-19 
infection between March 30, 2020, and June 30, 2021. 

To collect data, the clinical and radiological records of 
101 adult non-severe Covid-19 patients retrospectively 
reviewed who: 1. had at least two non-contrast chest CT 
images in stage 1 (0-4 days) and stage 6 (28 days) (12), 
2. had a positive RT-PCR test result at stage 1, and 3. had 
confirmed CT findings typical to Covid-19 pneumonia 
detected by a 20 years of experience radiologist. The severe 
of the COVID-19 score was determined as; development of 
respiratory rate more than 30 per minute, arterial partial 
pressure of oxygen (PaO2) / oxygen concentration (FiO2) 
of 300 mmHg or less, the rate of resting oxygen saturation 
was 93% or less, or needed mechanical ventilation (13).

Exclusion criteria were as following: 1. being younger than 
18 years of age, 2. being presenting with severe COVID-19 
or having a history of intubating (atrophy of the respiratory 
muscles is the expected finding in mechanically ventilated 
patients). 3. having a myasthenia gravis or similar muscle 
disease, 4. having distorted CT images due to major 
motion artifact, and 5. absence of pectoral and intercostal 
muscles on CT images. Lung volume (LV in cm³) and 
respiratory muscles’ cross-sectional areas (CSA in cm²) 
were calculated on the CT images in stage 1 and stage 6.

CT protocol

CT imaging carried out using with a single inspiratory phase 
in a multi-detector CT scanner (Philips Ingenuity Core 128, 
Philips, Netherlands). Participants were instructed on 
breath-holding to minimize of the motion artifacts, and 
CT images were obtained during a single breath-hold. 
The mean CTDI vol was 8.4±2.0 mGy (range: 5.2-12.6 
mGy). The tube voltage was 120kVp with automatic tube 
and from the raw data. CT images which thickness of 1.5 
mm were reconstructed with a matrix size of 512×512 
as axial images. No intravenous contrast medium was 
administered to any patient. 

Measuring lung volume

We used the ImFusion Suite program to calculate lung 
volumes. First, the original CT images that in Digital 
Imaging and Communications in Medicine (DICOM) 
format were converted to SPM8 (3D Niftii) format using 
the “dcm2niigui” software. These images were then used 
to calculate lung volume in the ImFusion Suite program. 

The steps can be summarized as following

1.	 “Interactive Segmentation” section was activated by 
selecting “Segmentation” under “Algorithms” tab in 
ImFusion Suite program.

2.	 For each image, the borders of the lungs were adjusted 
in the axial, coronal, and sagittal planes. These borders 
were painted in all 3 planes by selecting the “Paint 
Object” tab, to obtain a 3D representation of each lung.

3.	 By choosing the “Paint Background” tab, the 
background noise was eliminated.

4.	 Using the “Accept Segmentation”, “Run Segmentation”, 
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“Export as Label Map” and “Export as Annotation” tabs 
respectively, we completed the 3D model process.

5.	 Using the 3D models, the lung volumes were obtained 
via clicking on the “Show Segmentation Statistics” 
tab, then “Background” and then the “Object” tab. The 
whole process was repeated for the CT images of both 
stage 1 and 6 of each participant. The collected lung 
volumes (in mm³) were converted to cm³ and recorded.

Measuring cross-sectional areas of respiratory muscles

The measurement of the cross-sectional areas of the 
pectoral and intercostal muscles at the determined 
reference points was performed by two anatomists and a 
radiologist without access to clinical or laboratory findings. 
The mean of these three values was recorded in cm² for 
each muscle.

Cross-sectional area of the pectoral muscles
Pectoral muscles were chosen as auxiliary respiratory 
muscles. To calculate the cross-sectional surface area, 
all images saved in JPEG format were imported to the 
“ImageJ” program, that can be obtained free of charge from 
the https://imagej.nih.gov/ij/download.html. The images 
were created by selecting “stack   image to stack” tab 
under the “image” tab. In the RadiAnt program, using with 
the “measurement and tools” tab, one of the lengths of any 
structure selected location on the image and measured. 
Then, the measured location was selected in the same 
section and the image was calibrated using “Set Calibrate” 
located under the “Analyze” tab. Then, the pectoralis major 
(PMa) and pectoralis minor (PMi) muscles were determined 
manually with the reference point of the supraaortic 
arteries level using the “Free Hand” button of the ImageJ 
program (Figure 1). The cross-sectional surface areas of 
the muscles were calculated on an ImageJ tab using the 
“M” button. The entire process was repeated on both stage 
1 and stage 6 of the CT image of each participant and the 
results were recorded in cm². 
Cross-sectional area of the intercostal muscles
The intercostal muscles (ICM) were chosen as the main 
respiratory muscles. To calculate the cross-sectional 
surface areas, CT images -in DICOM format- were imported 
to the Imfusion Suite (demo version 2.15.1) program to get 
a 3D view on axial, sagittal, and coronal planes. These 3D 
images were used to create screenshots of the sections 
corresponding to the right and left midclavicular line on 
the sagittal axis. These screenshots -saved in the Joint 
Photographic Experts Group (JPEG) format- were imported 
to the ImageJ program. Using the “straight” button in the 
ImageJ program, the scale bar on the image was marked 
and the image was calibrated using with “Set Calibrate” 
under the “Analyze” tab. Then, in the ImageJ program, the 
borders of 1, -5 ICMs were identified with manually using 
the “Free Hand” button. Finally, the cross-sectional surface 
areas of the muscles were calculated on an ImageJ tab 
using the “M” key (Figure 2). This process was repeated 

on both stage 1 and stage 6 of the CT image of each 
participant and the results were recorded in cm².
Statistical analysis
We used Statistical Package for the Social Sciences 22.0 
program to evaluation. To check normality, we used visual 
(histograms, probability plots) and analytical methods 
(Kolmogorov-Smirnov/Shapiro-Wilk test). For categorical 
data we used descriptive statistics, reported counts, and 
proportions and we used data measures of distribution for 
continuous. To compare the baseline characteristics, we 
used an independent t test or χ2 test was performed. To 
assess the changes in the cross-sectional areas (CSA) of 
pectoralis major, pectoralis minor, and intercostal muscles 
and changes in the lung volumes, a 2*2 [stage (image 
changes in stage 1 and stage 6) * side (right or left)] 
repeated measures ANCOVA was performed with stage 
as a between-groups factor and side as a within-subjects 
factor, and with demographical measures set as the 
covariates. When the F-ratio was significant, Bonferroni’s 
post hoc test was used to identify the mean differences. 
Effect sizes were determined as partial eta squared (η²p). 
The significance level was set at p<.05.

RESULTS
One hundred and one participants (51 female, 50 male) 
with the diagnosis of Covid-19 were included in our 
study. Clinical and demographic characteristics of the 
participants are presented in Table 1. The examined 
stages were similar with respect to most assessed basic 
parameters (p>.05). There were significant differences 
in body mass index scores (p<.001) and the obesity rate 
(p<.001), both of which were higher in stage 1.

Table 1. Demographic and clinical characteristics of participants

Variable Stage 1 Stage 6 p

Age 51.14±14.92 - -

Body mass index (kg/m2) 28.48±5.98 25.72±4.74 <.001

Female (n, %) 51 (50.49%) - -

Days from symptom onset to 
study protocol - 30.12±2.41 -

Smoking rates (n, %) 17 (16.83%) 17 (16.83%) 1.00

Coexisting conditions 

Diabetes mellitus (n, %) 15 (14.85%) 15 (14.85%) 1.00

Obesity (BMI ≥ 30) (n, %) 29 (28.71%) 25 (24.75%) <.001

Hypertension (n, %) 29 (100%) 29 (100%) 1.00

COPD (n, %) 23 (100%) 23 (100%) 1.00

Independent samples t test or χ2 test; COPD: Chronic obstructive 
pulmonary disease
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ANCOVA revealed a significant stage*side interaction 
effect regarding CSA of intercostal muscle [(p=.010; 
η²p=.064)]. This value was smaller in stage 6 compared 
to stage 1 (Table 2). There was no significant difference 
between the two stages in terms of CSA of pectoralis 
major muscle [(p=.314; η²p=.010)], CSA of pectoralis 
minor muscle [(p=.644; η²p=.002)] and changes in the 
lung volume [(p=.340; η²p=.009)]. In addition, within-group 
analysis showed that the lung volume scores were higher 
for the right side both in stage 1 and 6 (p=<.001).

Figure 1. Measurement of the pectoral muscles. Cross-sectional 
area measurement of the pectoral muscles at the supra-aortic 
arteries level. PMa: Pectoralis major muscle; PMi: Pectoralis 
minor muscle

Figure 2. Measurement of the intercostal muscles. Cross-
sectional area measurement of the intercostal muscles at the 
midclavicular line. ICM: Intercostal muscle

DISCUSSION
The primary aim of our study was to determined the potential 
effects of Covid-19 infection on respiratory muscles 
and lung volume. As a secondary objective, by scanning 
impaired respiratory muscle performance and lung volume 
we tried to provide theoretical information and propose 
early rehabilitation strategies to alleviate the burden on the 
health system during the pandemic period. Evaluating the 
CT images of the same patients at stage 1 and stage 6 
revealed that Covid-19 pneumonia led to a decrease in the 
cross-sectional area of the intercostal muscles, whereas 
it caused no significant decrease in the cross-sectional 
area of the pectoral muscles nor in the lung volumes. In 
addition, 15% to 29% of the patients had an accompanying 
diagnosis of diabetes mellitus, obesity, and hypertension, 
indicating that people with underlying chronic diseases 
are more affected by Covid-19 pneumonia, as previously 
reported in similar studies. 

Table 2. Comparison of cross-sectional areas of muscles and changes in lung volume between the two stages

Stage 1 Stage 6 2 x 2 ANCOVA

Right Left p1 Right Left p1 Side p2 (η2p) Stage*Side p2(η2p)

PMa (cm2) 12.40±2.49 12.13±2.70 .73 11.23±2.43 11.07±2.73 .79 .677 (.002) .314 (.010)

PMi (cm2) 4.28±0.97 4.19±1.03 .88 3.91±0.90 3.83±1.04 .85 .807 (.001) .644 (.002)

ICM (cm2) 4.07±0.89 3.71±0.81 .12 3.84±0.86 3.50±0.81 .06 .059 (.035) .010 (.064)*

Lung volume (cm3) 2334.30±600.16 2092.30±576.33 <.001 2238.42±632.62 2035.06±592.88 <.001 <.001 (.297) .340 (.009)

PMa: Pectoralis major muscle; PMi: Pectoralis minor muscle; ICM: Intercostal muscle; p1: Independent samples t test results for within-stage side 
comparisons; p2: two-way repeated measures analysis of covariance with a mixed model. Figures in parentheses are effect sizes partial eta squared 
(η2p).
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Such as yawning and effective coughing behaviors 
are necessary to providing and maintaining pulmonary 
hygiene (14). This requires an optimal level of breathing 
together with optimal performance of the respiratory 
muscles. It is known that factors such as aging, smoking, 
obesity, chronic diseases, and physical inactivity increase 
respiratory workload and decrease respiratory muscle 
performance (15, 16). Previous studies have reported 
that the respiratory muscle weakness may increase the 
age-related decline in respiratory muscle performance in 
patients with multiple morbidity (16). Given the fact that 
the Covid-19 virus primarily affects the respiratory system 
and causes pneumonia, it is important to determine the 
impact of the infection on respiratory muscle performance. 
Currently, there are no studies directly investigating the 
effect of Covid-19 viral infection on respiratory muscles. 
In the present study, we obtained absolute values of the 
cross-sectional areas of the ICMs (as the main respiratory 
muscles) and the pectoral muscles (as the auxiliary 
respiratory muscles).  The obtained data showed that 
Covid-19 pneumonia can cause atrophy in the respiratory 
muscles in a period as short as four weeks. The relationship 
between respiratory muscle weakness and shortness of 
breath is clearly demonstrated (17). Thus, we think that 
Covid-19-induced atrophy in the respiratory muscles may 
increase the risk of acute respiratory distress syndrome 
and respiratory failure, increasing the need for mechanical 
ventilation support and increasing the length of stay in the 
intensive care unit. 
Lung volume measured on CT images, is closely related 
to pulmonary function test results such as forced vital 
and total lung capacities (18). Reduced lung volume may 
be an important sign of disease severity and prognosis of 
Covid-19 infection. Studies have reported that in severe 
cases of Covid-19, smaller CT lung volume is associated 
with alveolar collapse (6, 19). In the presented study, 
however, we found no significant decrease in the lung 
volumes between stage 1 (0-4 days) and stage 6 (>28 
days). One reason could be that the lung involvement 
does not reach the highest level at stage 1 of the disease. 
Previous studies have shown that in patients with Covid-19 
pneumonia, lung abnormalities on CT peak at about 10 
days after the first symptoms (12). Second reason for the 
absence of significant lung volume difference could be the 
improvement of lung involvement up until the 6th stage of 
the disease. 
The limitations of our study can be listed as following: 
First, lesion areas in the lungs were not evaluated. Second, 
prognostic data of the patients was not included due to 
unavailability of such data for some of the participants. 
Third, since physical or pulmonary performance levels 
of the participants were not recorded, they could not be 
compared with the tomographic parameters. Fourth, it was 
not specified from which mutations the participants were 
infected.

CONCLUSION
In conclusion, it can be concluded that Covid-19 pneumonia 

causes an atrophy in respiratory muscles. However, it 
seems to have a nonsignificant effect on lung volume. 
This indicates that despite the relation between lung 
volume and respiratory muscles, changes in respiratory 
muscle areas could occur independently of changes in 
lung volume. Current evidence suggests the need for 
further investigation of respiratory muscles and respiratory 
muscle training to reduce the risk of serious complications 
during viral infections. Moreover, the development of 
treatment strategies for weakened respiratory muscles 
may contribute to alleviating the burden on the health 
system during the current pandemic period.
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